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To	install,	create	the	hardware	directory,	then	unzip	the	third-party	platform	into	its	own	sub-directory.	The	toolbar	buttons	allow	you	to	verify	and	upload	programs,	create,	open,	and	save	sketches,	and	open	the	serial	monitor.NB:	Versions	of	the	Arduino	Software	(IDE)	prior	to	1.0	saved	sketches	with	the	extension	.pde.	Previous	versions	use	the
.pde	extension.	Allows	to	save	the	current	sketch	with	a	different	name.Page	Setup	It	shows	the	Page	Setup	window	for	printing.Print	Sends	the	current	sketch	to	the	printer	according	to	the	settings	defined	in	Page	Setup.Preferences	Opens	the	Preferences	window	where	some	settings	of	the	IDE	may	be	customized,	as	the	language	of	the	IDE
interface.Quit	Closes	all	IDE	windows.	Next	to	the	Editor	Language	there	is	a	dropdown	menu	of	currently	supported	languages.	These	sketches	are	written	in	the	text	editor	and	are	saved	with	the	file	extension	.ino.	The	boards	are	described	below.	Once	you've	selected	the	correct	serial	port	and	board,	press	the	upload	button	in	the	toolbar	or
select	the	Upload	item	from	the	Sketch	menu.	By	default,	the	IDE	loads	in	the	language	selected	by	your	operating	system.	This	command	also	set	the	right	fuses.HelpHere	you	find	easy	access	to	a	number	of	documents	that	come	with	the	Arduino	Software	(IDE).	See	below	for	descriptions	of	the	various	boards.Port	This	menu	contains	all	the	serial
devices	(real	or	virtual)	on	your	machine.	The	sketches	in	your	sketchbook	can	be	opened	from	the	File	>	Sketchbook	menu	or	from	the	Open	button	on	the	toolbar.	Equivalent	to	Arduino	Duemilanove	or	Nano	w/	ATmega328P;	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	NG	or	older	w/	ATmega168	An	ATmega168	running	at	16	MHzwithout	auto-
reset.	The	rest	can	be	found	in	the	preferences	file,	whose	location	is	shown	in	the	preference	dialog.Language	Support	Since	version	1.0.1	,	the	Arduino	Software	(IDE)	has	been	translated	into	30+	different	languages.	Note	that	on	Windows,	Mac	or	Linux	the	board	will	reset	(it	will	rerun	your	sketch)	when	you	connect	with	the	serial	monitor.	Use	a
potentiometer	to	control	the	blinking	of	an	LED.Read	a	potentiometer,	print	its	state	out	to	the	Arduino	Serial	Monitor.Turn	an	LED	on	and	off	every	second.Arduino	Uno	Board	AnatomyAn	overview	of	the	classic	Arduino	UNO.Read	a	switch,	print	the	state	out	to	the	Arduino	Serial	Monitor.Overview	of	the	Arduino	UNO	ComponentsAn	in-depth	look	at
the	classic	Arduino	UNO	board.Page	2Arduino	4	Relays	Shield	BasicsLearn	the	basics	of	how	relays	work,	and	how	to	control	the	four	relays	onboard	the	Arduino	4	Relays	Shield	Learn	how	the	Arduino	IDE	v1	works,	such	as	compiling	&	uploading	sketches,	file	management,	installing	dependencies	and	much	more.The	Arduino	Integrated
Development	Environment	-	or	Arduino	Software	(IDE)	-	contains	a	text	editor	for	writing	code,	a	message	area,	a	text	console,	a	toolbar	with	buttons	for	common	functions	and	a	series	of	menus.	Save	Saves	your	sketch.	Open	Presents	a	menu	of	all	the	sketches	in	your	sketchbook.	The	bootloader	will	blink	the	on-board	(pin	13)	LED	when	it	starts
(i.e.	when	the	board	resets).LibrariesLibraries	provide	extra	functionality	for	use	in	sketches,	e.g.	working	with	hardware	or	manipulating	data.	The	documents	are	a	local	copy	of	the	online	ones	and	may	link	back	to	our	online	website.Find	in	Reference	This	is	the	only	interactive	function	of	the	Help	menu:	it	directly	selects	the	relevant	page	in	the
local	copy	of	the	Reference	for	the	function	or	command	under	the	cursor.SketchbookThe	Arduino	Software	(IDE)	uses	the	concept	of	a	sketchbook:	a	standard	place	to	store	your	programs	(or	sketches).	With	older	boards	(pre-Diecimila)	that	lack	auto-reset,	you'll	need	to	press	the	reset	button	on	the	board	just	before	starting	the	upload.	The	Boards
Manager	included	in	the	standard	installation	allows	to	add	support	for	the	growing	number	of	new	boards	based	on	different	cores	like	Arduino	Due,	Arduino	Zero,	Edison,	Galileo	and	so	on.Arduino	Yún	An	ATmega32u4	running	at	16	MHz	with	auto-reset,	12	Analog	In,	20	Digital	I/O	and	7	PWM.Arduino	Uno	An	ATmega328P	running	at	16	MHz	with
auto-reset,	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	Diecimila	or	Duemilanove	w/	ATmega168	An	ATmega168	running	at	16	MHz	with	auto-reset.Arduino	Nano	w/	ATmega328P	An	ATmega328P	running	at	16	MHz	with	auto-reset.	However,	it	allows	you	to	use	the	full	capacity	of	the	Flash	memory	for	your	sketch.	The	archive	is	placed	in	the
same	directory	as	the	sketch.Fix	Encoding	&	Reload	Fixes	possible	discrepancies	between	the	editor	char	map	encoding	and	other	operating	systems	char	maps.Serial	Monitor	Opens	the	serial	monitor	window	and	initiates	the	exchange	of	data	with	any	connected	board	on	the	currently	selected	Port.	Has	eight	analog	inputs.Arduino	Mega	2560	An
ATmega2560	running	at	16	MHz	with	auto-reset,	16	Analog	In,	54	Digital	I/O	and	15	PWM.Arduino	Mega	An	ATmega1280	running	at	16	MHz	with	auto-reset,	16	Analog	In,	54	Digital	I/O	and	15	PWM.Arduino	Mega	ADK	An	ATmega2560	running	at	16	MHz	with	auto-reset,	16	Analog	In,	54	Digital	I/O	and	15	PWM.Arduino	Leonardo	An	ATmega32u4
running	at	16	MHz	with	auto-reset,	12	Analog	In,	20	Digital	I/O	and	7	PWM.Arduino	Micro	An	ATmega32u4	running	at	16	MHz	with	auto-reset,	12	Analog	In,	20	Digital	I/O	and	7	PWM.Arduino	Esplora	An	ATmega32u4	running	at	16	MHz	with	auto-reset.Arduino	Mini	w/	ATmega328P	An	ATmega328P	running	at	16	MHz	with	auto-reset,	8	Analog	In,	14
Digital	I/O	and	6	PWM.Arduino	Ethernet	Equivalent	to	Arduino	UNO	with	an	Ethernet	shield:	An	ATmega328P	running	at	16	MHz	with	auto-reset,	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	Fio	An	ATmega328P	running	at	8	MHz	with	auto-reset.	The	other	file	types	are	left	as	is.UploadingBefore	uploading	your	sketch,	you	need	to	select	the
correct	items	from	the	Tools	>	Board	and	Tools	>	Port	menus.	Please	note	that	this	command	will	NOT	burn	the	fuses.	Some	libraries	are	included	with	the	Arduino	software.	Clicking	one	will	open	it	within	the	current	window	overwriting	its	content.Note:	due	to	a	bug	in	Java,	this	menu	doesn't	scroll;	if	you	need	to	open	a	sketch	late	in	the	list,	use
the	File	|	Sketchbook	menu	instead.	On	Windows,	it's	probably	COM1	or	COM2	(for	a	serial	board)	or	COM4,	COM5,	COM7,	or	higher	(for	a	USB	board)	-	to	find	out,	you	look	for	USB	serial	device	in	the	ports	section	of	the	Windows	Device	Manager.	On	Linux,	it	should	be	/dev/ttyACMx	,	/dev/ttyUSBx	or	similar.	Equivalent	to	Arduino	Pro	or	Pro	Mini
(3.3V,	8	MHz)	w/	ATmega328P,	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	BT	w/	ATmega328P	ATmega328P	running	at	16	MHz.	The	bootloader	burned	(4	KB)	includes	codes	to	initialize	the	on-board	Bluetooth®	module,	6	Analog	In,	14	Digital	I/O	and	6	PWM..LilyPad	Arduino	USB	An	ATmega32u4	running	at	8	MHz	with	auto-reset,	4	Analog	In,	9
Digital	I/O	and	4	PWM.LilyPad	Arduino	An	ATmega168	or	ATmega132	running	at	8	MHz	with	auto-reset,	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	Pro	or	Pro	Mini	(5V,	16	MHz)	w/	ATmega328P	An	ATmega328P	running	at	16	MHz	with	auto-reset.	It	allows	you	to	upload	code	without	using	any	additional	hardware.	It	connects	to	the	Arduino
hardware	to	upload	programs	and	communicate	with	them.Writing	SketchesPrograms	written	using	Arduino	Software	(IDE)	are	called	sketches.	All	the	examples	are	structured	in	a	tree	that	allows	easy	access	by	topic	or	library.Close	Closes	the	instance	of	the	Arduino	Software	from	which	it	is	clicked.Save	Saves	the	sketch	with	the	current	name.	On
most	boards,	you'll	see	the	RX	and	TX	LEDs	blink	as	the	sketch	is	uploaded.	On	the	Mac,	the	serial	port	is	probably	something	like	/dev/tty.usbmodem241	(for	an	UNO	or	Mega2560	or	Leonardo)	or	/dev/tty.usbserial-1B1	(for	a	Duemilanove	or	earlier	USB	board),	or	/dev/tty.USA19QW1b1P1.1	(for	a	serial	board	connected	with	a	Keyspan	USB-to-Serial
adapter).	It	is	possible	to	open	these	files	with	version	1.0,	you	will	be	prompted	to	save	the	sketch	with	the	.ino	extension	on	save.	Because	libraries	are	uploaded	to	the	board	with	your	sketch,	they	increase	the	amount	of	space	it	takes	up.	The	bootloader	is	active	for	a	few	seconds	when	the	board	resets;	then	it	starts	whichever	sketch	was	most
recently	uploaded	to	the	microcontroller.	Current	Arduino	boards	will	reset	automatically	and	begin	the	upload.	This	is	not	required	for	normal	use	of	an	Arduino	board	but	is	useful	if	you	purchase	a	new	ATmega	microcontroller	(which	normally	come	without	a	bootloader).	The	message	area	gives	feedback	while	saving	and	exporting	and	also
displays	errors.	To	send	data	to	the	board,	enter	text	and	click	on	the	"send"	button	or	press	enter.	It	should	automatically	refresh	every	time	you	open	the	top-level	tools	menu.Programmer	For	selecting	a	hardware	programmer	when	programming	a	board	or	chip	and	not	using	the	onboard	USB-serial	connection.	If	the	file	hasn't	been	named	before,
a	name	will	be	provided	in	a	"Save	as.."	window.Save	as...	Select	your	preferred	language	from	the	menu,	and	restart	the	software	to	use	the	selected	language.	Similarly,	after	changing	your	operating	system's	settings,	you	must	restart	the	Arduino	Software	(IDE)	to	update	it	to	the	new	default	language.BoardsThe	board	selection	has	two	effects:	it
sets	the	parameters	(e.g.	CPU	speed	and	baud	rate)	used	when	compiling	and	uploading	sketches;	and	sets	and	the	file	and	fuse	settings	used	by	the	burn	bootloader	command.	You	can	find	a	comparison	table	between	the	various	boards	here.Arduino	Software	(IDE)	includes	the	built	in	support	for	the	boards	in	the	following	list,	all	based	on	the	AVR
Core.	The	console	displays	text	output	by	the	Arduino	Software	(IDE),	including	complete	error	messages	and	other	information.	(Note:	on	Windows	and	possibly	Linux,	this	is	determined	by	the	locale	setting	which	controls	currency	and	date	formats,	not	by	the	language	the	operating	system	is	displayed	in.)If	you	would	like	to	change	the	language
manually,	start	the	Arduino	Software	(IDE)	and	open	the	Preferences	window.	You	may	still	open	.pde	named	files	in	version	1.0	and	later,	the	software	will	automatically	rename	the	extension	to	.ino.Tabs,	Multiple	Files,	and	CompilationAllows	you	to	manage	sketches	with	more	than	one	file	(each	of	which	appears	in	its	own	tab).	Upload	Compiles
your	code	and	uploads	it	to	the	configured	board.	Choose	the	baud	rate	from	the	drop-down	menu	that	matches	the	rate	passed	to	Serial.begin	in	your	sketch.	Downloading	and	installing	the	Arduino	IDE	2.0A	quick	guide	on	how	to	install	the	IDE	2.0	on	your	operative	system.How	to	upload	a	sketch	with	the	Arduino	IDE	2.0Learn	the	basics	of
verifying	and	uploading	sketches	with	the	new	IDE	2.0.The	Autocomplete	FeatureLearn	how	the	autocomplete	feature	works	with	Arduino	IDE	2.0,	and	how	it	can	help	speed	up	your	development	time.Installing	new	boardsLearn	how	the	new	board	manager	tool	works,	and	how	to	easily	install	the	boards	you	want	to	use	in	the	Arduino	IDE
2.0.Synchronizing	Sketches	between	IDE	2.0	and	Arduino	CloudLearn	how	to	enable	your	Remote	Sketchbook,	and	how	to	pull,	edit	and	push	Sketches	to	the	Arduino	Cloud.Debugging	with	the	Arduino	IDE	2.0Learn	how	to	set	up	a	Zero	board,	J-Link	and	Atmel-ICE	debuggers	with	the	Arduino	IDE	2.0,	and	how	to	debug	a	program.Updating
Firmware	version	and	Uploading	CertificatesLearn	how	to	update	the	firmware	on	your	WiFi	boards,	and	how	to	upload	SSL	Root	Certificates.Installing	librariesLearn	how	to	install	software	libraries	with	the	new	library	manager	tool	in	the	Arduino	IDE	2.0.Using	the	Serial	Monitor	toolLearn	how	to	use	the	new	Serial	Monitor	tool	in	the	Arduino	IDE
2.0,	and	how	it	works	differently	from	older	versions.Using	the	Serial	Plotter	ToolLearn	how	to	setup	and	use	the	Serial	Plotter	in	the	Arduino	IDE	2.	To	use	a	library	in	a	sketch,	select	it	from	the	Sketch	>	Import	Library	menu.	The	first	time	you	run	the	Arduino	software,	it	will	automatically	create	a	directory	for	your	sketchbook.	Normally	you	won't
need	this,	but	if	you're	burning	a	bootloader	to	a	new	microcontroller,	you	will	use	this.Burn	Bootloader	The	items	in	this	menu	allow	you	to	burn	a	bootloader	onto	the	microcontroller	on	an	Arduino	board.	The	Arduino	Software	(IDE)	will	display	a	message	when	the	upload	is	complete,	or	show	an	error.When	you	upload	a	sketch,	you're	using	the
Arduino	bootloader,	a	small	program	that	has	been	loaded	on	to	the	microcontroller	on	your	board.	See	uploading	below	for	details.Note:	If	you	are	using	an	external	programmer	with	your	board,	you	can	hold	down	the	"shift"	key	on	your	computer	when	using	this	icon.	Additionally,	from	this	menu	item	you	can	access	the	Library	Manager	and
import	new	libraries	from	.zip	files.Add	File...	Others	can	be	downloaded	from	a	variety	of	sources	or	through	the	Library	Manager.	Platforms	installed	there	may	include	board	definitions	(which	appear	in	the	board	menu),	core	libraries,	bootloaders,	and	programmer	definitions.	This	will	insert	one	or	more	#include	statements	at	the	top	of	the	sketch
and	compile	the	library	with	your	sketch.	The	file	is	saved	to	the	data	subfolder	of	the	sketch,	which	is	intended	for	assets	such	as	documentation.	This	setting	will	take	effect	when	you	restart	the	Arduino	Software	(IDE).	To	do	so	a	Tools	->	Burn	Bootloader	command	must	be	executed.Export	Compiled	Binary	Saves	a	.hex	file	that	may	be	kept	as
archive	or	sent	to	the	board	using	other	tools.Show	Sketch	Folder	Opens	the	current	sketch	folder.Include	Library	Adds	a	library	to	your	sketch	by	inserting	#include	statements	at	the	start	of	your	code.	Compilation	and	upload	is	equivalent	to	Arduino	Diecimila	or	Duemilanove	w/	ATmega168,	but	the	bootloader	burned	has	a	slower	timeout	(and
blinks	the	pin	13	LED	three	times	on	reset);	6	Analog	In,	14	Digital	I/O	and	6	PWM.Arduino	Robot	Control	An	ATmega328P	running	at	16	MHz	with	auto-reset.Arduino	Robot	Motor	An	ATmega328P	running	at	16	MHz	with	auto-reset.Arduino	Gemma	An	ATtiny85	running	at	8	MHz	with	auto-reset,	1	Analog	In,	3	Digital	I/O	and	2	PWM.For	instructions
on	installing	support	for	other	boards,	see	third-party	hardware	above.	Adds	a	supplemental	file	to	the	sketch	(it	will	be	copied	from	its	current	location).	The	bottom	righthand	corner	of	the	window	displays	the	configured	board	and	serial	port.	This	usually	resets	the	board,	if	the	board	supports	Reset	over	serial	port	opening.Board	Select	the	board
that	you're	using.	(Don't	use	"arduino"	as	the	sub-directory	name	or	you'll	override	the	built-in	Arduino	platform.)	To	uninstall,	simply	delete	its	directory.For	details	on	creating	packages	for	third-party	hardware,	see	the	Arduino	Platform	specification.Serial	MonitorThis	displays	serial	sent	from	the	Arduino	board	over	USB	or	serial	connector.	If	a
sketch	no	longer	needs	a	library,	simply	delete	its	#include	statements	from	the	top	of	your	code.There	is	a	list	of	libraries	in	the	reference.	For	more	details,	see	libraries	below.	Please	note	that	the	Serial	Monitor	does	not	process	control	characters;	if	your	sketch	needs	a	complete	management	of	the	serial	communication	with	control	characters,
you	can	use	an	external	terminal	program	and	connect	it	to	the	COM	port	assigned	to	your	Arduino	board.You	can	also	talk	to	the	board	from	Processing,	Flash,	MaxMSP,	etc	(see	the	interfacing	page	for	details).PreferencesSome	preferences	can	be	set	in	the	preferences	dialog	(found	under	the	Arduino	menu	on	the	Mac,	or	File	on	Windows	and
Linux).	The	editor	has	features	for	cutting/pasting	and	for	searching/replacing	text.	You	can	view	or	change	the	location	of	the	sketchbook	location	from	with	the	Preferences	dialog.Beginning	with	version	1.0,	files	are	saved	with	a	.ino	file	extension.	You	have	access	to	Getting	Started,	Reference,	this	guide	to	the	IDE	and	other	documents	locally,
without	an	internet	connection.	The	menus	are	context	sensitive,	which	means	only	those	items	relevant	to	the	work	currently	being	carried	out	are	available.FileNew	Creates	a	new	instance	of	the	editor,	with	the	bare	minimum	structure	of	a	sketch	already	in	place.Open	Allows	to	load	a	sketch	file	browsing	through	the	computer	drives	and
folders.Open	Recent	Provides	a	short	list	of	the	most	recent	sketches,	ready	to	be	opened.Sketchbook	Shows	the	current	sketches	within	the	sketchbook	folder	structure;	clicking	on	any	name	opens	the	corresponding	sketch	in	a	new	editor	instance.Examples	Any	example	provided	by	the	Arduino	Software	(IDE)	or	library	shows	up	in	this	menu	item.
Starting	with	version	1.0.5	of	the	IDE,	you	do	can	import	a	library	from	a	zip	file	and	use	it	in	an	open	sketch.	Ensure	that	you've	selected	the	correct	board	from	the	Boards	menu	before	burning	the	bootloader	on	the	target	board.	If	your	operating	system	language	is	not	supported,	the	Arduino	Software	(IDE)	will	default	to	English.You	can	return	the
software	to	its	default	setting	of	selecting	its	language	based	on	your	operating	system	by	selecting	System	Default	from	the	Editor	Language	drop-down.	The	same	sketches	open	when	Quit	was	chosen	will	be	automatically	reopened	the	next	time	you	start	the	IDE.EditUndo/Redo	Goes	back	of	one	or	more	steps	you	did	while	editing;	when	you	go
back,	you	may	go	forward	with	Redo.Cut	Removes	the	selected	text	from	the	editor	and	places	it	into	the	clipboard.Copy	Duplicates	the	selected	text	in	the	editor	and	places	it	into	the	clipboard.Copy	for	Forum	Copies	the	code	of	your	sketch	to	the	clipboard	in	a	form	suitable	for	posting	to	the	forum,	complete	with	syntax	coloring.Copy	as	HTML
Copies	the	code	of	your	sketch	to	the	clipboard	as	HTML,	suitable	for	embedding	in	web	pages.Paste	Puts	the	contents	of	the	clipboard	at	the	cursor	position,	in	the	editor.Select	All	Selects	and	highlights	the	whole	content	of	the	editor.Comment/Uncomment	Puts	or	removes	the	//	comment	marker	at	the	beginning	of	each	selected
line.Increase/Decrease	Indent	Adds	or	subtracts	a	space	at	the	beginning	of	each	selected	line,	moving	the	text	one	space	on	the	right	or	eliminating	a	space	at	the	beginning.Find	Opens	the	Find	and	Replace	window	where	you	can	specify	text	to	search	inside	the	current	sketch	according	to	several	options.Find	Next	Highlights	the	next	occurrence	-
if	any	-	of	the	string	specified	as	the	search	item	in	the	Find	window,	relative	to	the	cursor	position.Find	Previous	Highlights	the	previous	occurrence	-	if	any	-	of	the	string	specified	as	the	search	item	in	the	Find	window	relative	to	the	cursor	position.SketchVerify/Compile	Checks	your	sketch	for	errors	compiling	it;	it	will	report	memory	usage	for	code
and	variables	in	the	console	area.Upload	Compiles	and	loads	the	binary	file	onto	the	configured	board	through	the	configured	Port.Upload	Using	Programmer	This	will	overwrite	the	bootloader	on	the	board;	you	will	need	to	use	Tools	>	Burn	Bootloader	to	restore	it	and	be	able	to	Upload	to	USB	serial	port	again.	The	contents	of	the	data	folder	are	not
compiled,	so	they	do	not	become	part	of	the	sketch	program.Auto	Format	This	formats	your	code	nicely:	i.e.	indents	it	so	that	opening	and	closing	curly	braces	line	up,	and	that	the	statements	inside	curly	braces	are	indented	more.Archive	Sketch	Archives	a	copy	of	the	current	sketch	in	.zip	format.	See	these	instructions	for	installing	a	third-party
library.To	write	your	own	library,	see	this	tutorial.Third-Party	HardwareSupport	for	third-party	hardware	can	be	added	to	the	hardware	directory	of	your	sketchbook	directory.	Some	of	the	board	definitions	differ	only	in	the	latter,	so	even	if	you've	been	uploading	successfully	with	a	particular	selection	you'll	want	to	check	it	before	burning	the
bootloader.	The	text	will	change	to	"Upload	using	Programmer"	New	Creates	a	new	sketch.	Verify	Checks	your	code	for	errors	compiling	it.	These	can	be	normal	Arduino	code	files	(no	visible	extension),	C	files	(.c	extension),	C++	files	(.cpp),	or	header	files	(.h).Before	compiling	the	sketch,	all	the	normal	Arduino	code	files	of	the	sketch	(.ino,	.pde)	are
concatenated	into	a	single	file	following	the	order	the	tabs	are	shown	in.	Serial	Monitor	Opens	the	serial	monitor.Additional	commands	are	found	within	the	five	menus:	File,	Edit,	Sketch,	Tools,	Help.

With	the	Arduino	CLI	you	can	build	sketches,	upload	programs,	download	libraries	or	board	definitions,	and	do	much,	much	more.	Most	importantly,	the	Arduino	CLI	gives	us	a	command-line	interface	that	can	be	triggered	from	VS	Code	to	build	and	upload	Arduino	sketches.	Download	Arduino	CLI.	Arduino	CLI	is	still	in	its	infancy	of	development.
Esta	línea	significa	que	ha	incluido	(#include)	la	librería	servo	(servo.h).Se	hace	poniendo	el	símbolo	menor	que	().	Con	esta	simple	acción	ya	podríamos	utilizar	todas	las	funcionalidades	de	la	librería	de	Arduino	servo,	es	muy	sencillo.Vuelvo	a	repetir,	sólo	tienes	que	ir	a	Programa>Incluir	Librería	y	seleccionar	la	que	…
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